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Disclaimer 
This document is for informational purposes only and is subject to change without notice. This document and its 
contents, including the viewpoints, dates and functional content expressed herein are believed to be accurate as of its 
date of publication. However, Epicor Software Corporation makes no guarantee, representations or warranties with 
regard to the enclosed information and specifically disclaims any applicable implied warranties, such as fitness for a 
particular purpose, merchantability, satisfactory quality or reasonable skill and care. As each user of Epicor software 
is likely to be unique in their requirements in the use of such software and their business processes, users of this 
document are always advised to discuss the content of this document with their Epicor account manager. All 
information contained herein is subject to change without notice and changes to this document since printing and 
other important information about the software product are made or published in release notes, and you are urged to 
obtain the current release notes for the software product. We welcome user comments and reserve the right to revise 
this publication and/or make improvements or changes to the products or programs described in this publication at 
any time, without notice. The usage of any Epicor software shall be pursuant to an Epicor end user license 
agreement and the performance of any consulting services by Epicor personnel shall be pursuant to Epicor's standard 
services terms and conditions. Usage of the solution(s) described in this document with other Epicor software or 
third party products may require the purchase of licenses for such other products. Where any software is expressed 
to be compliant with local laws or requirements in this document, such compliance is not a warranty and is based 
solely on Epicor's current understanding of such laws and requirements. All laws and requirements are subject to 
varying interpretations as well as to change and accordingly Epicor cannot guarantee that the software will be 
compliant and up to date with such changes. All statements of platform and product compatibility in this document 
shall be considered individually in relation to the products referred to in the relevant statement, i.e., where any 
Epicor software is stated to be compatible with one product and also stated to be compatible with another product, it 
should not be interpreted that such Epicor software is compatible with both of the products running at the same time 
on the same platform or environment. Additionally platform or product compatibility may require the application of 
Epicor or third-party updates, patches and/or service packs and Epicor has no responsibility for compatibility issues 
which may be caused by updates, patches and/or service packs released by third parties after the date of publication 
of this document. Epicor® is a registered trademark and/or trademark of Epicor Software Corporation in the United 
States, certain other countries and/or the EU. All other trademarks mentioned are the property of their respective 
owners.  

Copyright © Epicor Software Corporation. All rights reserved. No part of this publication may be reproduced in any 
form without the prior written consent of Epicor Software Corporation. 
Publication Date: April 3, 2018 
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B2B Commerce Overview 
B2B Commerce, an Eclipse companion product, establishes electronic trading relationships with other 
Eclipse users. You can use it to check your vendors' stock and pricing, and procure items over the 
Internet. Other Eclipse users can check your stock availability and pricing, and conveniently place orders 
with you. Building on the data-interchange flexibility of the XML (Extensible Markup Language) 
standard, B2B Commerce enables the electronic marketplace. 

B2B Commerce extends the power of the Eclipse Internet Gateway and Eclipse Web Commerce 
companion products. Each partner in the electronic trading relationship needs an Eclipse system with the 
Eclipse Internet Gateway and the B2B Commerce companion products; or you can have Eclipse 
customize B2B Commerce for you, so you can trade with partners on other computer systems. 

After setup, you and your salespeople can check all your procurement sources over the Internet in real 
time, simplifying price and service comparisons. Also, you can have the products shipped directly to your 
customer or your warehouse. 

Click here for a printable version of the B2B Commerce documentation. 

See Also: 

Procurement From B2B Commerce Vendors Overview 

B2B Commerce for Customers Overview 
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Setup Requirements for B2B Commerce 
Following are the control maintenance records and authorization keys used for Eclipse B2B Commerce, 
along with additional setup requirements. 

Control Maintenance Records 
Set the following control maintenance records: 

• B2B Inventory Control Maintenance 

• B2B Punchout Product Info Setup 

• Default B2B Customer Templates 

Authorization Keys 
Assign the following authorization keys: 

• WOE.MAINT 

Setting Up Customers, Vendors, and Products 
Set up your customer and vendor records for use with B2B Commerce. Synchronize products, so you and 
your vendors are identifying the same products in the same way. 

Complete the following tasks to complete your B2B Commerce setup: 

• Setting up customers. 

• Setting up vendors. 

• Synchronizing products. 

See Also: 

B2B Commerce Overview 
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Setting Up Vendors for B2B Commerce 
Set up each vendor you want to access using B2B Commerce by specifying the web site, login 
information, and procurable items from each vendor. 

To set up a vendor for B2B Commerce: 

1. Display the character-based system. 

Note: The B2B Commerce functionality has not been incorporated into Solar Eclipse as 
of this release. 

2. From the Files menu, select Vendor to display the Vendor Maintenance screen. 

3. Open or create a vendor maintenance record. 

4. Use the WWW hot key to display the Internet Information Maintenance screen. 

5. Use the B2B Commerce hot key to open the vendor's Eclipse B2B Commerce Vendor 
Maintenance screen. 

6. In the WWW Address field, enter the full Uniform Resource Locator (URL) path used to access 
the vendor’s B2B web site. Include the ”r;http://” in the URL. 

For example, http://www.thewidgetspro.com. Use the Expand WWW Address hot key to enter 
or view a web site address that is longer than the display area on the screen. 

7. Enter the login information you use to access the vendor’s web site: 

Field Description 
Customer ID Your company-assigned login identification. 

Login The login ID for the customer. 

Password Your company-assigned login password. 

8. In the Preferred Remote Site New Order Status field, press F10 and select the default status for 
orders placed remotely to this vendor. 

9. Specify the items you may want to procure from this vendor. 

You can enter individual products, price lines, product groups, or allow all items. Use a separate 
line for each entry. As shown in the column heading above the entry area, use the following 
syntax to enter your choices: 

Syntax Description 
*ALL Specifies that all items from this vendor are procurable. 

Eclipse Product ID Specifies particular products that are procurable. 

The price line name preceded by 
a forward slash (/) 

Specifies a price line, for example, enter /ABC. 

The group name preceded by an 
exclamation point (!) 

Specifies a product group, for example, enter !ABC. 
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10. Use the Test Connection hot key to test your connection access to the vendor. The system 
attempts to connect to the vendor's web address, using your login information. 

If the connection test is... Then... 
successful the following message displays: 

Good Customer Number and Password. Connection was successful. 

not successful a message displays with troubleshooting information. For example, 
the message might indicate that the password you specified is invalid, 
or the web server would not allow a certain method. The message 
often displays detailed HTML information that you can use to 
determine the connection problem. Consult with the web experts at 
your company or Eclipse for assistance. 

11. Press Esc until you return to the Vendor Maintenance screen. 

See Also: 
Procurement From B2B Commerce Vendors Overview 

Vendor Maintenance Overview 
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Setting Up Customers for B2B Commerce 
Set up your customers' login settings before they access your B2B Commerce web site or Eclipse system 
for the first time. Because you use Customer Maintenance settings, you already have control over each 
customer's pricing, ship via, credit terms, and so on. You can also control how much of your inventory 
displays to the customer. For more information, see Controlling Product Inventory. 

To set up a customer for B2B Commerce: 

1. From the Maintenance menu, select Customer to display the Customer Maintenance window. 

2. Open or create a customer maintenance record. 

3. From the Orders menu, select Remote Order Entry Parameters to display the Remote Order 
Entry Parameters window. 

4. From the Edit menu, select WOE Information to display the B2B/WOE Remote Order Entry 
Parameters window. 

5. In the B2B WOE Password field, enter the password you want your customer to use. 

Note: If you run the Web Commerce companion product, the password you enter in this 
field is also used for your customer's access to your web site. 

6. In the B2B Post URL fields, enter the Uniform Resource Locator (URL) for posting billing files 
for the transactions listed. These URLs are the web addresses where you send the customer's 
billing information, such as invoices. The system uses the default URL for any document that 
does not have a specific URL indicated. 

7. Save your changes and return to the Customer Maintenance window. 

8. Make note of the customer number, which displays in the lower left corner of the Customer 
Maintenance window. 

9. Save the customer record and exit the window. 

10. Provide the password and customer number to your customer, so they can use those login settings 
when they set up their own software. 

See Also: 

Controlling Product Inventory for B2B Customers 

B2B Commerce for Customers Overview 
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How the System Synchronizes Products in B2B Commerce 
In Eclipse B2B Commerce, you and your vendors must identify all the procurable products the same way. 
The best way to do this is to use matching Universal Product Codes (UPCs). 

When the system is not able to find and match a UPC between you and your vendor, it looks at the 
following field entries in the order shown. A match on any of these other field entries allows B2B 
Commerce product synchronization between your company and the vendor: 

Field Screen Displaying the Field 
Cust/Vendor Part 
Number 

Customer/Vendor Part Number Detail 
Path: Orders > Inquiries > Customer Part Numbers 
For more information, see Customer/Vendor Specific Part Numbers Overview. 

Catalog # Price Updating ID Maint 
Path: On the UPC Codes Maintenance screen, use the UD Maint hot key. 

User Defined #1 Price Updating ID Maint 
Path: On the UPC Codes Maintenance screen, use the UD Maint hot key. 

Additional Key Words Product Maintenance 
Path: Files > Product 

Product ID Product Maintenance 
Path: Files > Product 

Note: Eclipse Product Data Warehouse (PDW) offers a convenient way to manage UPC 
codes. 

See Also: 

Synchronizing Products Using UPCs 

Synchronizing Products Using Product Data Warehouse 

Product Data Warehouse Overview 
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Synchronizing Products Using UPCs 
Before using B2B Commerce, ensure that you and your vendor are identifying products you can procure 
the same way. The easiest way to do this is by using matching Universal Product Codes (UPCs). Because 
a UPC is a practical way to specify products, the system uses this method first to match products between 
your company and the vendor. If a UPC is not available, the system uses the methods listed in How the 
System Synchronizes Products. 

To verify or edit a UPC code: 

1. From the Maintenance menu, select Product to display the Product Maintenance window and 
display a product. 

2. From the Additional Data menu, select UPC Code Maintenance to display the UPC Codes 
Maintenance window. 

3. Compare the UPC number with those of your B2B vendor's UPC for the product and edit as 
necessary. 

4. Save your changes and exit the window. 

See Also: 

How the System Synchronizes Products 

Synchronizing Products Using Product Data Warehouse 
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Synchronizing Products Using Product Data Warehouse 
Use Product Data Warehouse (PDW) to store millions of product records in the system. You can integrate 
product and pricing data from the PDW.CATALOG with the system product file for all stock items and 
for any nonstock or new items that you enter on a transaction. 

Use PDW to download data from many sources, for example, Internet and CD-ROM, and merge that 
information. Use built in mapping agents to update any changes, including UPC information. 

UPC information is available from vendors, manufacturers, and other third-party services. 

Contact your Eclipse salesperson for information about ordering PDW. 

See Also: 
Product Data Warehouse Overview 

Synchronizing Products Using UPCs 

How the System Synchronizes Products 
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Procurement From B2B Commerce Vendors Overview 
Use B2B Commerce to perform real-time inquiries over the Internet into your procurement sources. After 
you set up the contact and product information for your vendors, you can check their current stock and 
prices. 

Note: For information about setting up B2B vendors for item procurement, see Setting 
Up Vendors for B2B Commerce. 

To procure products from your vendors using B2B Commerce, identify which vendors you use in a 
business-to-business setting. Synchronize your products with your vendors so that you are procuring the 
correct products. For example, both you and your vendors need to assign a product the same UPC or the 
same ID so when you order the product, you can identify the correct one with its unique ID. 

To procure a product, complete the following tasks: 

• Start a B2B Commerce inquiry. 

• Perform a B2B Commerce inquiry. 

• Send the order to the B2B vendor. 

See Also: 

B2B Commerce Overview 

Setting Up Vendors for B2B Commerce 
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Starting B2B Commerce Inquiries 
Use Eclipse B2B Commerce to perform an inquiry into your vendors' product inventories. Start an inquiry 
in one of the following ways: 

• Start a product inquiry with the product information populated on the screen. This is the most 
common method. 

• Start a blank inquiry so you can enter the product information allowing you to check on products 
before adding them to the order. 

Starting a Product Inquiry 
If you start the inquiry from the product's Scheduling screen, the Eclipse B2B Commerce window opens 
with the product description and other information populated. 

To start a product inquiry: 

1. From the Orders menu, select Sales Order Entry to display the Sales Order Entry window. 

2. Open or create a sales order. 

3. With the cursor on the procurable product, from the Line Item menu, select Schedule the 
product's Scheduling screen. 

4. Navigate to a future ship date when there is an available shipping quantity. 

5. From the Edit menu, select B2B to open the Eclipse B2B Commerce window. 

6. Perform the inquiry. 

Starting a Blank Inquiry 
Alternatively, you can open a blank Eclipse B2B Commerce window. You can then enter any desired 
product description for an inquiry. This is useful if you want to check on products before adding them to 
the order. 

To start a blank inquiry: 

1. From the Orders menu, select Sales Order Entry to display the Sales Order Entry window. 

2. Open or create a sales order. 

3. From the Edit menu, select B2B to open the Eclipse B2B Commerce window. 

4. Perform the inquiry. 

See Also: 

Procurement From B2B Commerce Vendors Overview 

Performing B2B Commerce Inquiries 

Sending Orders to B2B Vendors 
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Performing B2B Commerce Inquiries 
Perform a B2B Commerce inquiry to check vendors' current inventory and prices for a product, in real 
time. You can perform an inquiry for one vendor, or perform an inquiry for all vendors. 

To perform a B2B Commerce inquiry: 

1. From the Orders menu, select Sales Order Entry to display the Sales Order Entry window. 

2. Start the inquiry. 

3. Verify that the desired product description displays on the Eclipse B2B Commerce window. The 
system displays the corresponding data in the view-only columns. 

Field Description 
Description The product description. This field is editable if you started with a 

blank Eclipse B2B Commerce screen. 

Product 
Information 

Status The product status, for example, Stock or Nonstock, which is used 
for inventory control and cataloging. 

Weight The product weight, if specified. The weight can indicate whether 
the demand for a product in a particular buy line contributes to 
meeting a vendor target for weight. 

Load The load factor of the product, if specified. The load factor 
represents the cubic dimensions of a product or the point value of a 
product (from a vendor specification sheet) towards meeting a 
vendor target for load factor. 

Package 
Quantity 

The package quantity for the product, if specified. For example, 
the product might be packaged in quantities of a dozen. 

Buy Line The product buy line, if specified. The buy line indicates all the 
products that are normally purchased together from a vendor. 

Price Line The price line to which this product belongs. Price lines can group 
products according to vendor or product type, and so on. Price 
lines are often used for reporting and ranking. 

B2B Vendor The names of the vendors from whom you can purchase this 
product using B2B Commerce. For more information, see Setting 
Up Vendors for B2B Commerce. 

Status The status of the information connection. Temporarily displays 
*Send* while an inquiry is in progress at the selected vendor. 

Avail Qty The real-time product quantity available from a vendor. 

Your Price The price you pay to procure the product from the vendor. 

Vendor's 
Description 

The product description the vendor uses, so you can verify that it is 
the correct product. Displays ** PRODUCT NOT FOUND ** if 
an inquiry does not find the product. 

Detail The detailed branch and available quantity information for a 
vendor that carries the product. 

Note: Populates after an inquiry runs. 
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5. From the File menu, select one of the following to perform an inquiry: 

• One Inq - Performs an inquiry with the vendor selected by your cursor position. 

• All Inq - Performs inquiries with all vendors shown. 

The Status column temporarily displays SEND while an inquiry is in progress at the 
corresponding vendor. The Detail column updates to display the results of your inquiry. 

6. If the product availability and price are satisfactory, from the File menu, select Send Order to 
send the order to the selected vendor. 

See Also: 

Starting B2B Commerce Inquiries 

Sending Orders to a B2B Vendors 

Procuring Items from B2B Commerce Vendors 
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Sending Orders to B2B Vendors 
You can immediately send an order to a vendor, directly from the Eclipse B2B Commerce screen. Send 
an order after you perform an inquiry, and are satisfied with the vendor's product availability and price. 
The system sends the order to the vendor using the document type appropriate for the B2B application 
you are running, Eclipse B2B Commerce, IDMS XML, or Business Connect XML. 

Specify whether to ship the order direct to your customer or to your warehouse. 

To send an order to a B2B vendor: 

1. Display the character-based system. 

Note: The B2B Commerce functionality has not been incorporated into Solar Eclipse as 
of this release. 

2. From the Orders menu, select Sales Order Entry to display the Sales Order Entry screen. 

3. Start the inquiry. 

4. Verify that the desired product information displays on the Eclipse B2B Commerce screen. 

5. Perform an inquiry. 

6. Use the Send Order hot key to order the product procurement from the selected vendor. 

The P/O Type list displays. 

7. Indicate how you want the product shipped by selecting one of the following shipping methods: 

Shipping Method Description 
Direct Shipment Ships the procurement directly from the vendor to your customer. Enter 

the ship via at the prompt. 

Procure Sends the purchase order to the Procurement Confirmation Queue, where 
your buyers review and approve the order. 

Tagged P/O Ships the procurement to your company. The order is on a tagged 
purchase order, so your receivers know to place the inventory in a tagged-
item area and not in stock. Enter the ship via at the prompt. 

See Also: 
Procurement From B2B Commerce Vendors Overview 
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B2B Commerce for Customers Overview 
You can use B2B Commerce to set up your customers to procure items from your inventory. With B2B 
Commerce, your customers can perform real-time inquiries into your inventory, yet you can control how 
much of your inventory and what products in your inventory they see. 

After you complete the following tasks, you are able to receive orders from your customers through B2B 
Commerce. 

• Setting Up Customers for B2B Commerce 

• Controlling Product Inventory 

See Also: 

B2B Commerce Overview 

Procurement From B2B Commerce Vendors Overview 
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Controlling Product Inventory for B2B Customers 
A system administrator can precisely control how much of your inventory displays when your trading 
partners or B2B customers perform an inquiry into your system. Controlling your product inventory 
protects your inventory details. 

Using the Product Ranking screen and the B2B Inventory Control Maintenance screen, assign the 
following parameters: 

• Rank - Indicates the products' demand. 

• Basis - Further breaks down the product ranks. Use the basis along with the multiplier to 
calculate the amount of inventory that displays to your B2B business partner. 

• Multiplier - The number by which to multiply the basis to determine the amount of inventory 
that displays. 

For common settings, see Common Inventory Control Settings. 

Product Inventory Example 
Products in Rank #1 equal 50 percent of your most demanded products. The A-ranked products in Rank 
#1 are based on the number of times the product was sold (hits). You only want 20 percent of your A-
ranked products' order point (the minimum amount of inventory you want to have on your shelves) to 
display to your B2B customers. Enter the following settings: 

• Rank = 1 

• Basis = Order Point 

• Multiplier = .20 

Anyone inquiring about an A-ranked product would only see 20 percent of your order point inventory as 
the available quantity. So, while you might have 100 of the product in inventory, the inquiry only shows 
20. 

Controlling Product Inventory 
You can control inventory on a global level using the B2B Inventory Control Maintenance control 
maintenance record or at the individual customer level through that customer's maintenance settings. 

To control product inventory globally: 

1. Display the character-based system. 

Note: The global B2B inventory control functionality has not been incorporated into 
Solar Eclipse as of this release. 

2. From the System > System Files menu, select Control Maintenance to display the Control 
Maintenance screen. 

3. In the Keyword field, type B2B Inventory Control to open the B2B Inventory Control 
Maintenance screen. 

4. In the Br/Tr/All field, enter the branch or territory for which you want to control inventory. 

5. In the Rank # field, enter the rank number for the products you want to control. 
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6. In the Basis field adjacent to the Rank letter, press F10 and select the basis amount to use for 
calculating how much of your inventory to display: 

Basis Option Description 
Available Calculates based on all inventory currently available. 

Order Point Calculates based on inventory at order point. The order point is the minimum 
amount of an item you want to have on the shelf. 

Line Point Calculates based on inventory at line point. The line point is the maximum 
amount of an item you want to have on the shelf. 

7. In the Multiplier field, enter the percentage by which to multiply the basis. 

For example, entering .20 shows 20 percent of the basis inventory. 

8. Press Esc to apply your settings and close the screen. 

To control product inventory for a customer: 

1. From the Maintenance menu, select Customer to display the Customer Maintenance window. 

2. Open or create a customer maintenance record. 

3. From the Orders menu, select Remote Order Entry Parameters to display the Remote Order 
Entry Parameters window. 

4. From the Edit menu, select B2B Inventory Control to display the B2B Inventory Control 
Maintenance window. 

5. In the Branch field, enter or select the branches or territories you want to control. 

6. In the Rank # field, enter the rank number for the products you want to control and click Update. 

7. In the Basis column adjacent to the Rank letter, enter or select the basis amount to use for 
calculating how much of your inventory to display: 

Basis Option Description 
Available Calculates based on all inventory currently available. 

Order Point Calculates based on inventory at order point. The order point is the minimum 
amount of an item you want to have on the shelf. 

Line Point Calculates based on inventory at line point. The line point is the maximum 
amount of an item you want to have on the shelf. 

8. In the Multiplier column, enter the percentage by which to multiply the basis. 

For example, entering .20 shows 20 percent of the basis inventory. 

9. Save your changes and return to the Customer Maintenance window. 

10. Save the customer record and exit the window. 

See Also: 

Common B2B Inventory Control Settings 

Setting Up Customers for B2B Commerce 
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Common B2B Inventory Control Settings 
The following table provides common settings, using Order Point as the Basis field setting. Use these as a 
starting point, but adjust these settings for your business conditions and individual trading relationships. 

Rank Multiplier Percentage of Inventory Showing 
A 1.20 120% 

B 1.00 100% 

C .40 to .80 40 to 80% 

D 0.00 0% 

See Also: 
Controlling Product Inventory for B2B Customers 
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